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2. #aev MPLAB X IDE

lUsinsa MPLAB X IDE asnsasmiuluaaldain URL 2093UUs®n Microchip
(U7t 2.1) #oil

https://www.microchip.com/en-us/tools-resources/develop/mplab-x-ide

“ @MICHOCHIP Products Solutions Tools and Resources ~ Support Education About Order Now Q 2 B

Tools and Resources / Develop / MPLAB® X IDE

Downloads and Documentation Ecosystem

MPLAB® X IDE

MPLAB® X Integrated Development Environment (IDE) Q
MPLAB® X Integrated Development Environment (IDE) is an expandable, highly configurable M P L AB

software program that incorporates powerful tools to help you discover, configure, develop,

debug and qualify embedded designs for most of our microcontrollers and digital signal K) I D E

controllers. MPLAB X IDE works seamlessly with the MPLAB development ecosystem of

software and tools, many of which are completely free. v

sUA 2.1 wiIuzee MPLAB X IDE
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- X U setp X
Setup - MPLAB X IDE v6.00 License Agreement %
-
Welcome to the MPLAB X IDE v6.00 Setup Wizard. gl A t. You must of this agreement before continuing with the
installation.

[MICROCHIP 1s WILLING TO LICENSE THE SOFTWARE AND TO YOU ONLY ON THE A
|CONDITION THAT YOU ACCEPT ALL OF THE FOLLOWING TERMS. TO ACCEPT THE TERMS OF THIS LICENSE,

WITH THE DOWNLOAD OR INSTALL. IF YOU DO NOT ACCEPT THESE LICENSE
™ AND DO NOT DOWNLOAD OR INSTALL THIS SOFTWARE

E AGREEMENT FOR MPLAB® IDE SOFTWARE

se Agreement ("Agzeer

© [Tacceptthe agreement

Do accept this license ?
youaccept T e et h e

<Back | [“Net> ]| conce <Back Next> Cancel

sUT 2.2 ($10) wibusnzosluswnsu@ase MPLAB X IDE
(271) nrhasdudunmsyansudaanaslunisidmy

U setup - U setup -

3.

X
Installation Options ,?&E Select Applications

{
L

Installation Directory:

Choose which applications you want to install:
Proxy Settins
o ;ﬂ mf £ MPLAB X IDE (Integrated Development Environment)
[ MPLAB IPE (Integrated Programming Environment)
@ Use System Proxy Settings
Choose Microchip device support you want installed:
£ & bit MCUs (2268)
The MPLAB team appreciates your help to improve the MPLAB X products. Microchip wil not collect user credentials, paths, [ 16 bit MCUs (1.7GB)
filenames, project names, or fragments of user's source code. [ 32 bit MCUs (3.068)
E4 1 consent to allow the collection of anonymous information about my usage of MPLAB products to assist in better

dthe of [ Other MCUs (SERIALEE, HCSwoxx) (4.9M8)

1 1would like to enable Product Changes Notices through MPLAE X. This will enable MPLAB X to share data on product and

tools | use to MyMicrochip profile. | agree to receiving additional emails on product changes that relate to the products |
uuuuu MPLAB X and I'can change my at igh nt.
< Back Next > Cancel

< Back Next > Cancel

sUA 2.3(¢18) wihimualadnnedaase MPLAB X IDE
(37) n¥hmuuagamluanmu1aIsu MPLAB X IDE

MnsURl 2.3 Fudvasnuideumansassylanneddmsuiiasaldsenuies
wazndvnmnuaiaaluiunoudaludumsidondasundooiionlamul  laogidon
\onlflanz 8 bit MCU ndvnnsilidiiiumsidoningiunaumsnadudalumudsu
LazspAUNIMSsBARI IS A HIISUA 2.5
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U sewp - X O sewp - X
Ready to Install % Installing )%
-
Setup is now ready to b LAB X IDE y puter. Please wait while Setup installs MPLAB X IDE v6.00 on your computer.
Installing
Creating directory C:[..J0\mplab,_platiorm\data-visualizer\releasenotes
1
,,,,,,,,,,,,,,,,,,,,, -
Back 7| [T Next> Cancel Backl] [SNet> ) | Conce

SUA 2.4 (478) Fafade MPLAB X IDE wdundon@insa (291) MPLAB X IDE fifiums@nsa

- X
Completing the MPLAB X IDE v6.00 Setup Wizard
Setup has finished installing MPLAB X IDE v6.00 on your computer.
[ Launch MPLABX IDE
[ Launch MPLABX IPE
[J XC compilers are not installed with the IDE.
Go to microchip.com/MPLABxc to download a compiler
[J Download MPLAB Harmony Integrated Software Framework and
configurator (MHC) from microchip.com/harmony to simplify
32 bit project development
[ simplify 8/16/32 bit project development by downloading MPLAB
Code Ci (MCC) from mi ip.com/mcc to generate C
code using graphical interface
< Back Cancel

sUT 2.5 mihaes19uEEaaunsings MPLAB X IDE

U

3. fiagla MPLAB XC8 C-Compiler
lUsunsn MPLAB XC8 C-Compiler ugasnuianiundamsululasaonlnsaaas
amdeunssy 8 Onzosusunlulasen lauwsesfeiflidonfaderiassuvuiuins

Windows, Linux az macOS 21n URL gewduuddn Microchip (5Ufl 2.6) tl

https://www.microchip.com/en-us/tools-resources/develop/mplab-xc-compilers

unfl 2 ukzihgandls © 2022 lay 9150 UASIia waznoufa WNKIA
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' @MICHOCHIP Products Solutions Tools and Resources ~ Support Education About OrderNow Q 2 &

Tools and Resources / Develop / MPLAB® XC Compilers / MPLAB XC Compiler Downloads and Documentation

MPLAB XC8 Compiler

MPLAB XC8 Compiler Downloads

+ Title Version Number Date Download
MPLAB XC8 C-Compiler (Windows) . I8 2dcb138c... Obfd 2.40 15 Jul 2022 Download
MPLAB XC8 C-Compiler (macOS) 3. I8 5889b2fe... 9a8c 2.40 15Jul 2022 Download
MPLAB XC8 C-Compiler (Linux) X, 1l 761ea80d... 3fc5 2.40 15)Jul 2022 Download

sUA 2.6 widuaasiluan MPLAB XC8 C-Compiler

pavanldlnafasaldisuinnmsinge MPLAB XC8 C-Compiler snusiiaggnein
omsfaaulugUfl 2.7 flv 2.10

- X L) Setup — X
Setup - MPLAB XC8 C Compiler License Agreement . @N
-
Welcome to the MPLAB XC8 C Compiler Setup Wizard. Please read the following License Agreement. You must accept the terms of this
g before inuing with the il i
[MICROCHIP IS WILLING TO LICENSE THE ACCOMPANYING SOFTWARE AND A

[DOCUMENTATION TO YOU ONLY ON THE CONDITION THAT YOU ACCEPT ALL OF
[THE FOLLOWING TERMS. TO ACCEPT THE TERMS OF THIS LICENSE, CLICK
"I ACCEPT" AND PROCEED WITH THE DOWNLOAD OR INSTALL. IF YOU DO

> NOT ACCEPT THESE LICENSE TERMS, CLICK "I DO NOT ACCEPT," AND DO
COMPILER [NOT DOWNLOAD OR INSTALL THIS SOFTWARE.

[NON-EXCLUSIVE SOFTWARE LICENSE AGREEMENT FOR MPLAB® XC8 C COMPILER

This Nonexclusive License (" ) is a
contract between you, your heirs, successors and assigns
("Licensee”) and Microchip Technology I a Delaware v

Do you accept this license? i
b et O I do not accept the agreement

allBuilder

Zack | [ Next> || Cancel | <Back Next > Cancel

sUfi 2.7 ($1e) nrhaoBuusnovsfinga MPLAB XC8 C-Compiler
(a71) nrhaadenlanisld MPLAB XC8 C-Compiler

L) Setup - X L) Setup - X
ueuis | s
License Type conth ere Installation Directory e
- -

MPLAB XC8 C Compiler can be installed to run in Free mode,
with a workstation license, or as a network client.

@ Free
O Workstation
O Network Client

Please specify the directory where MPLAB XC8 C Compiler will be installed.

[QESTETTL TS CLAI C:\Program Files\Microchip'\xc8\v2. 400 Il aS]

Gancel l < Back Next > ‘ Cancel

sUTI 2.7 ($e) wihaodanUszsnngeunissi XC8 (291) wihaaszylasnnasaog XC8

unit 2 uugiinganduas. © 2022 lag 9150 UASITID waznaufia BNk
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L3 Setup - X L3 Setup - X
. . LA s
Compiler Settings Ready to Install Compiler
S -
Apply settings to all users of this machine Setup is now ready to begin installing MPLAB XC8 C Compiler on your computer.

[J Add xc8 to the PATH environment variable

<Back | [ Next> Cancel <Back || Next> | Cancel

sUN 2.8 (1) nrhaeneaimsfinay XC8 (231) wihaasieaunsanfnsy XC8

NNSUA 2.7 dnuamasnuhdemaansadenladnnesdmsuiadasi MPLAB
xcs C-Compiler 1¢ uwazanmnsaidenmsevrniioliiszuunaufiugalusunsulddons
Win PATH ¢lasUAl 2.8 dude ndvaniuiiondn Next sovmsBufiamoszuuazasas
sURl 2.9 duthe Tdseauniimsiaduadadudosy 2.9 fusndudunmsldsiazos
wiovdulusunsuldadolaronmuds wdvanduadn Next Losifiunusdeazny
nigdgenugU 2.10 L{“‘Juﬂw's?{yuq@ﬂw'sa@ﬁa MPLAB XC8 C-Compiler

) Setup - X

Installing : Installation Complete - Licensing Information

Please wait while Setup installs MPLAB XC8 C Compiler on your computer. If you want to use the FREE MPLAB XC8 C Compiler, Click Next.
If your Compiler is already licensed, Click Next.

Installing
Unpacking C:\Program [...]Microchip\xc8\v2.40\avr\man\man1\avr-ranlib.1 Click to purchase a PRO license

Click here to get a free 60-day evaluation of PRO

If you have an Activation Key:

Click here to activate your license

Your Host ID is: c07cd1f7e2ft}

< Back Next > Cancel < Back Next > Cancel

sUT 2.9 (F18) wihaofiasalna XC8 auazov (371) wiasmnuasHalaadnluswnsnAasmy XC8

unfl 2 ukzihgandls © 2022 lay 9150 UASIia waznoufa WNKIA
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L) Setup - X
Completing the MPLAB X(8 C Compiler Setup Wizard

Setup has finished the requested actions for MPLAB XC8 C

Compiler on your computer.
xX L

COMPILER

-

<Bock | [Fnish | | Concel

*g‘uﬁ 2.10 wihaelaSafumsAnsy MPLAB XC8 C-Compiler

4. 1% MPLAB X IDE

aduiuneureemsiilusunsy MPLAB X IDE (5U71 2.11) iietdenlusunsunun
FUsznoudy 5 dumawn Ao
519l dlasven
F519lndn g
aSudulsanisiusianossoululasaoulnsaaosidonld
Bouldauazaoulng
lndnadnsluBonasdn

ok~ w o=

&3 MPLAB X IDE v6.00 _ - x
File Edit View Navigate Source Refactor Production Debug Tesm Tools Window Help Q- Search (b
rEHES DE BT B P TEQB Q0w oK ]

Projects x | Files | Classes | Services El

Q| |prionty  message = Date Created Category

sUAl 2.11 wihaelusunsa MPLAB X IDE
4.1 @51lAseau

Pnuraelugul 2.11 TWedndeonwy File Waldonasulaseniuainsiuns
New Project... shugufl 2.12 ($e) wavanuuazlnisvlfifonusannaoolaseinu

unit 2 uugiigavduas. © 2022 lay 9150 UASITIa waznaufia BnaG
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fovmsasasugUfl 2.12 (291) lWBeniluuszinn  (Categories) wuu  Microchip
Embedded wazlasevsids Standalone Project wdaadn Next tivosniinnssold

23 MPLAB X IDE v6.00

| &
File Edit View Navigate Source Refactor Production
. 5 Steps Choose Project
1 NewProject... Ctrl+Shift+N
9 NewFile... Ctri+N ; Choose Project Q Filter:
ﬁ Open Project... Ctrl+Shift+0 ;aeegones: Projects:
Open Recent Project > [l WMicrochip Embedded (&4 Standalone Project
) Other Embedded (& Existing MPLAB IDE v8 Project
Import > 3£ Samples (& Prebuilt (Hex, Loadable Image) Project
& Generic (& User Makefile Project
Close Project : Q Library Project
Close Other Projects Q Import START MPLAB Project
Close All Projects (&4 Import Atmel Studio Project
Open File...
Open Recent File >
Project Groups...
Project Properties
Description:
Save Ctrl+S Creates a new standalone application project. It uses an IDE-generated makefile to build your
Save As. project.
Save All Ctrl+Shift+S

Page Setup...

Print... Ctrl+Alt+Shift+P

Print to HTML...

Next > Finish Help
Exit

SUA 2.12 ($19) wyasalaseun (221) wihaeidonusannlaseni

NNSUT 2.13 ($he) Dudumeumsidenusannvestlilaspenlnsaiaasiiidonts
loolusotradon PIC18F458 suludnlumszna Advanced 8-bit MCUs (PIC18) wan
Asn Next Liedonzyataseuilontvamuilusunsumuddesuit 2.13 (am) Teeidonls
O XC8 udrsuiumsiunouruuadelasenuuazladnnosifiulnddsud 2.14 ($he)
Lazangiunongarnuzesmsadivlasanufioselin MPLAB X IDE a$1elasvousng 1
IaSadnnazacldnadnsdosy 2.14 (am) Wumsugaiunouseamsasielaseonu

3 New Project X B3 New Project x
Steps Select Device Steps Select Com
1. Choose Project 1. Choose Project
2. Select Device 2. Select Device
3. Select Header Family: Advanced 8-bit MCUs (PIC18) 3. Select Header
4. Select Plugn Board 4. Select Plugn Board
:: ::‘n‘mm-u Device: 5. ;:-:n?k:‘w"
Folder Fode HLTECH PICC18 R0
I s R
MPLAB MPLAB
X IDE X IDE
v v
Back Next Cancel Help Back. -Next> Cancel Help
sUT 2.13 (F10) Mnuedniildlulasanu (a71) Bonwzovlowlaniul

unfl 2 ukzihgandls © 2022 lay 9150 UASIia waznoufa WNKIA
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3 New Project X ° @
C o B F-H bR R Dow @ o Py
1. Choose Project Soriem
[ ect Ok Project Name: Gettngstart
4. Select Pon Board X . —
. Project Locaton: Cipic
6
Folder inc E c
ettgstar - Dusbbos_ | martumad 3|
et as main project et et
(1) Use project location as the project folder T [ty omeen [T —
= To|o mewoevces wnpock upport eesses Cmmcsoon e |
= Q
Encodng: U8
<Bock | | Mext Frs Cancel Heb

SUT 2.14 (F10) suBolasamunasiiAulaseu (821) Whiaolloas1ulasenasawaD

4.2 \AnlWa 3

nnurhaslusufl 2.15 azdainaiinlnaimesso Source Files anufiu Projects
lusromslasonumuderidali  (usegnofiduudetoliu  GettingSart) Bvazwuinlu
Wawesitlddlnala 1 egmelu duriu SedovrhmsiRulndmugiinludiomsasn
a7l Source Files azuamosumMsiuydonni 2.16 (o) Wdendu C Main File...
pdoannuuazuaneutihsedogy 2.16 (37) werhmuadoralnafiasre Tnelusetoi
as19lnd8e main.c wazaznuilulnaimes Source Files a:filnddo main.c UsingZwuss
sUR 2.17 (7)) wazdoyamelulndidusosy 2.17 (am)

’Projects x| Files  Classes | Services | El{
- (L) GettingStart

[+ @ Header Files

@[ Important Files

[+ ﬁ Linker Files

@ (R Source Files

@[ Libraries

& (@@ Loadables

sUA 2.15 IWlawmes Source Files dususnlndn v

[Felsource Fil

New | & Directo B3 New C Main File X
(@ Libraries -
5@ Loadables New Logical Folder ] CMainFile.. Steps Name and Location

Add Existing ltem... @] xc8_headerh... L Choose File Type Fie Name: |main.c|

2. Name and Location

Add Existing Items from Folders... @ avr-main.c.. Extension:

Find... &) pic_8b_asm_func.asm...

i & main.c..

Cut Project: GettngStart

. [ TextFile...

Copy Folder Browse...
Paste Ctrl+V Other... Created Fie: |C:\pic\GettngStart.X\main.c
Remo ve From Project

Rename...

Properties

Unil 2 uuzigenduas. © 2022 lag 9150 UAsITia waznoufia BRI
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(Yo}

SUT 2.16 ($1e) e msuasty C Main File (291) wisuszyBalndnmu@fidounisasie

Pro..x | Files | Clas... Ejmanc x

- GettingStart sowce Hsoy @ B-H-ATTELH(PLB|aU 0B
- ([[F) Header Files
+ ﬁ Important Files
+ @] Linker Files
5-(g) Source Files

] main.c

+ ﬁ Libraries
+ @ Loadables

I
Il
£a

TR B T B S S S

-
(=

o
w N
—

main(int argc, char** argv) {

return (EXIT ESS):

o e
R T,
——1]
b
o
ot

sUA 2.17 ($1v) BolWdmunBiiagredu (am) Welulndn w3 MPLAB X IDE adalss

4.3 d@519%ayan15AvAN
WlovdrudnlulasaeulnsataosMidonldtuildninuigrinuiininninniiy
Uszranasufilgnanluluuni 1 sunu JidouldsunsnFodovaasnisyiteulsiiu

@RS 9 rhnihfimiuanisoiunadnsnisyuzalalasroulnsalaes
lagpsouiogoy MPLAB X IDE $095UNMSa5 1990482005 alaosuarAlsns

JovisTawasyoudnlulasaoulnsaaasidonlHrulianluid s wdoiisunaat
FUADUIDINISHAAISIINISISAALADS AT 00NLSTALA0S NS o NANE NAWo oL T
Foamnunazrhdoanumaifaasnaslnanungiasrviuandunoulumde 4.2

%u@@uLLSﬂZﬁLﬁaﬂSWEJﬂ’ISLNH Configuration Bits aanwny Target Memory Views
2oy Window ﬁog‘d‘ﬁ 2.18 a:zfistwmsudiude Configuration Bits Lﬁmﬁwmﬁa‘guﬁ 2.19
Isimanditn Generate Source Code to Output flagduarvsovuiiu azldnadnsaalén
Aagr0guusingluuiiu output dasudt 2.20

unfl 2 ukzihgandls © 2022 lay 9150 UASIia waznoufa WNKIA
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Window Help
‘2 MPLAB Discover
Kit Window
B Projects Ctrl+1
Files Ctrl+2
& Classes Ctrl+9
Favorites Ctrl+3
B Senvices Ctrl+5
%8 Dashboard
® Navigator Ctrl+7
ed Action ltems Ctrl+6
E Tasks Ctrl+Shift+6
= Output Ctrl+4
Editor Ctrl+0
Debugging
Web
IDE Tools

Simulator

@ Programming Center

Configure Window
Reset Windows

Close Window Ctrl+W
Close All Documents Ctrl+Shift+W
Close Other Documents.

Document Groups

Documents... Shift+F4

Program Memory

File Registers
SFRs

Configuration Bits

EE Data Memory
User ID Memory

.18 wyuanay Configuration Bits

1 CPO OFF Code Protection bit Block 0 (000200-001FFFh) not code protected
1 CP1 OFF Code Protection bit Block 1 (002000-003FFFh) not code protected
1 P2 OFF Code Protection hit Block 2 (004000-005FFFh) not code protected ¥
< >
Memory |ConfigurationBits v | Format |Read/Write v/ SR “

Iﬂm|1li@||'5§

tions | Output  Configuration Bits x | =
Address Name Value Field Option Category Setting
300001 CONFIG1H 27 - |- - [— ~
7 0sC RCIO Oscillator Selection bits RC oscillator w/ 0SC2 configured as RA6
1 0SCS  OFF Oscillator System Clock Switch Enable bit  Oscillator system clock switch option is dis

300002 CONFIG2L OF - - -

1 PWRT OFF Power-up Timer Enable bit PWRT disabled
1 BOR OoN Brown-out Reset Enable bit Brown-out Reset enabled
3 BORV 25 Brown-out Reset Voltage bits VBOR set to 2.5V

300003 CONFIG2H OF - - -

1 WDT ON Watchdog Timer Enable bit

WDT enabled

7 WDTPS 128 Watchdog Timer Postscale Select bits

1:128

300006  CONFIG4L 85 - - -

1 STVR ON Stack Full/Underflow Reset Enable bit

Stack Full/Underflow will cause Reset

1 LVP ON

Low-Voltage ICSP Enable bit

Low-Voltage ICSP enabled

300008 CONFIGSL OF - - -

U

sUfi 2.19 uitu Configuration Bits

| Output - Config Bits Source x| C ion Bits =
#pragma config WRT3 = OFF // Write Protection bit (Block 3 (00€000-007FFFh) not write protected) ~
// CONFIGEH
#pragma config WRIC = OFF // Configuration Register Write Protection bit (Configuration registers (300000-3000FFh) not write protected)
$pragma config WRIB = OFF // Boot Block Write Protection bit (Boot Block (000000-0001FFh) not write protected)
#pragma config WRTD = OFF // Data EEPROM Write Protection bit (Data EEPROM not write protected)
// CONFIG7L
$pragma config EBTRO = OFF // Table Read Protection bit (Block 0 (000200-001FFFh) not protected from Table Reads executed in other blocks)
$pragma config EBTRL = OFF // Table Read Protection bit (Block 1 ( FFh) not from Table Reads executed in other blocks)
$pragma config EBTR2 = OFF // Table Read Protection bit (Block 2 ( FFh) not from Table Reads executed in other blocks)
$pragma config EBTR3 = OFF // Table Read Protection bit (Block 3 (00€000-007FFFh) not protected from Table Reads executed in other blocks)
// CONFIGTH
$pragma config EBTRB = OFF // Boot Block Table Read Protection bit (Boot Block 1FFh) not from Table Reads executed in other blocks)
// $pragma config statements should precede project file includes.
// Use project enums instead of gdefine for ON and OFF.
g¢include <xc.h>

v

sUAl 2.20 TAafiag19ann Configuration Bits

unit 2 uugiinganduas. © 2022 lag 9150 UASITID waznaufia BNk
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1ngufl 2.20 THdendaaanidarionnaluely main.c fuwadnslugufl 2.21
navNHlEYINMsTWAnlWa main.c

@ |4 5%

g
z
.|
]
&
a
¥
Vi
i
%
¢
UU
I
[N

[

W W o s W N

[l el
W N o

b
[T

gma config OSC = RCIO
yma config OSCS = OFF

._.
o
A
.-
¥
8 8

sUfl 2.21 feehe main.c Auiia Configuration Bits wily

4.4 aonlwa
wdvanldlndlusunsundnzovniuiBuaznisaeansuduadiususnlulas
Aoulnsalaes PIC ufiiBuudesandunoun 4.3 lineasvrihmsaenlnadlusunsusae
msaanfivndmsueeulng (Build) dasufl 2.22 ($ne) useadnfignassuanzedlonen
Woluansiemsismsaonlndandusggy 2.22 (w21) Widendu Build Main Project

57 MPLAB XC8 C-Compiler azsnfinnisaanlnaldalulnaniundfioglulaseenuiiasi

U

Y

P BArsIIHNAZaIMSADNINALHLAU Output fasee1ugy 2.23 18
NMss19vH BUILD SUCCESSFUL wasvil@amonlnarinandgiunauilndnadnsiy
lUsunsuadnsaly wddfdoRanainazsovrhmsualaldaannitazaoulnanig

| ! N o » C‘LP::’ v . v A v L- : v
i T D@

Build Main Project

Build for Debugging Main Project

18 7])

o

Build with PRO Comparison Main Project

sUM 2.22 (%e) loroumanlna (271) stemsedudovdmsunanlng

unfl 2 ukzihgandls © 2022 lay 9150 UASIia waznoufa WNKIA



12 AnavnailNeielg PIC16/18

Output x| C Bits =
Config Bits Source x  GettingStart (Build, Load) x

tringStart.X/dist/default/production/Ge
pack, PIC18Fxxxx_DFP, 1.3.3€,Microchip

sUT 2.23 g unadnsannsaonlng

Indnadns ivhluidouavdnazluinana HEX lawgldainunu Files Tulnawmos
production flegmelu Belaseuw/dist/default Fosuii 2.24 uazifloduadniilndazgn
\Davonundasufi 2.25 damdndioemsiinhlulusunsuaednsslusunsy PICKit2 adov
dhlululnawmes production uladn default foglulnawnad dist meluladnnesfadi
Tasonmonld dwnsdififvanslasenuegluudiu Projects feuanunsaidonaonlng
frumsaananiiselasenuiidesmsaonlndudidonsiums Build desu 2.26 IdEuin

| Projects | Files *  Classes Services D‘
£ GettingStart
&) build
=) dist
=~ default
=}-(J) production
[ GettingStart.X.production.cmf
(@ GettingStart.X.production.elf
C
GettingStart.X.production.hx!
GettingStart.X.production.lst
GettingStart.X.production.map
GettingStart.X.production.mum
GettingStart.X.production.o
GettingStart.X.production.rif
GettingStart.X.production.sdb
GettingStart.X.production.sym
memoryfile.xml

= ) ) P

+-|J) nbproject
P Makefile
& main.c

SUA 2.24 s1emslwalu production

Unil 2 uuzigenduas. © 2022 lag 9150 UAsITia waznoufia BRI



dupanalanInIg PIC16/18 13

@ main.c x| [] GettingStart.X.production.hex x| (DOIEHO
Sowce Hstory [ BB QG FELR PR (U0 @ |

1 |0600000000FOFIEF1FF0O13 A

2| :103FF000FEFF0001FCEF1FFOFFEFO1EFO0FOFEFFEC N
3| :020000040020DA

4| :08000000FEFEFEFEFEFEFEFE00

5| :020000040030CA

€ :04000000EF270FOEBS

7| :0800060085FFOFCOOFEO0F4061

8| :00000001FF

]

o

2.25 fhagudionali .HEX

el
c
=

a MPLAB X IDE v6.00 - GettingStart : default
File Edit View Navigate Source Refactor Production Debug Team Tools

ﬁ : " [dafault 1%-?

New >

Add Existing Item... —
Add Existing Items from Folders...

: New Logical Folder

" Unker F Locate Headers

E} El "; Add Item to Important Files...

(@@ Librarie: Export Hex
Ee gy
Clean and Build

Clean
Batch Build...

SU 2.26 vt Build tlaadnzridondilaseeu

u

o

faealnd main.c dwsu PICI8F458 fldrinnisusuamdnnisyinaiuwaltdusoi
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#pragma config 0SC = HS
#pragma config 0SCS = ON
#pragma config PWRT = OFF
#pragma config BOR = ON
#pragma config BORV = 25
#pragma config WDT = OFF
#pragma config WDTPS = 128
#pragma config STVR = ON
#pragma config LVP = ON
#pragma config CPO = OFF
#pragma config CP1 = OFF
#pragma config CP2 = OFF
#pragma config CP3 = OFF
#pragma config CPB = OFF
#pragma config CPD = OFF
#pragma config WRTO = OFF
#pragma config WRT1 = OFF
#pragma config WRT2 = OFF
#pragma config WRT3 = OFF
#pragma config WRTC = OFF
#pragma config WRTB = OFF
#pragma config WRTD = OFF
#pragma config EBTRO = OFF
#pragma config EBTR1 = OFF
#pragma config EBTR2 = OFF
#pragma config EBTR3 = OFF
#pragma config EBTRB = OFF

#include <xc.h>
#define _XTAL_FREQ 20000000
void main(void) {

return;

}

Lazfoe19 main.c @1usu PIC16F877 vJu

Unil 2 uuzigenduas. © 2022 lag 9150 UAsITia waznoufia BRI
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#pragma config FOSC
#pragma config WDTE
#pragma config PWRTE =
#pragma config CP = OFF
#pragma config BOREN = ON
#pragma config LVP = ON
#pragma config CPD = OFF
#pragma config WRT = ON

#include <xc.h>
#define _XTAL_FREQ 20000000

void main(void) {
return;

2/
a (4

5. eiaea PICKit2

ms@asalusunsy PICKit 2 T#Bwunanlnawesfidedn PICKIT 2.61 Setup
dotNET (5uUfi 2.27) tidnlululnaweddunanuioBenlusunsufnsufidodn setup.exe
(5UN 2.28) warl@niedgevgun 2.29 Usingaumn

oo/
@Qv[ | « ET-PGMPIC USBV1-V2 » Tools » v [ 49 ||| sissr2 Tools Iy
Jasnduy ¥ = e ldizamsin v Seam v Tuaeaas o = 0 @&
< swmslisa - \IRUT]%‘ tond3 SarZuemar  Iwaiaas ¥
& ariilinaa Tools
sarifiay . 1T : R ELH TSI EHTR ¥iia V1A

=L dumisaianga

. PICkit 2 Setup v2.40c 8/1/2553 14:55 Tunraasidia
= lownt . PICkit 2 Setup v2.40c dotNET ~ 8/1/2553 14:55 1 ;
rJ" s . PICkit 2 v2.51 Setup A 8/1/2553 14:55 !
&) qumw . PICkit 2 v2.51 Setup dotNET A 8/1/2553 14:55 -_1:,45;:33;'55’;{;1
E 15T 18 . PICKIT2.61 Setup dotNET 8/1/2553 14:55 Tslaraasiila

PICKIT2.61 Setup dotNET Fudiulsussiauss: 8/1/2553 14:55

Taraasusia

sUA 2.27 TWawmas PICKIT 2.61 Tuurndfzeg ET-PGM PIC USB V1-V2

unfl 2 ukzihgandls © 2022 lay 9150 UASIia waznoufa WNKIA
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g .
oo s
@U" . « Tools » PICKIT2,61 Setup dotNET » v | ‘y’ #4327 PICKIT2.61 Setup dotNET je '
dasuduy ¥ da ldizamsin v S vz Tuasaaslosi = 0 @
fa -~ =
B vancifau laun3 enans By Tovand ~
=) s ] IALTUININL Watas
SIS PICKIT2.61 Setup dotNET
= | - | #n Tufiddudfou ¥iia B9
@ s | dotnetfx 8/1/255314:56  Tumsaadiidla
=] sumw B ﬂ’_-.:j] PICkit2Setup.msi 25/3/2552 7:34 uwarna W 4,131 KB
M salo L) setup.exe 25/3/25527:34  Tusunssil.. 421 KB
] sanms
""; L setup.exe Tufiddualauu: 25/3/2552 7:34 Fufindre 8/1/2553 14:55
\@ Tusunsslszyna vaa: 420 KB

sUA 2.28 lopaulusunsu@asa PICKit 2

15 PICKit 2 v2.61 o] & (==
Welcome to the PICKkit 2 v2.61 Setup Wizard Q
MicrocHIP

The installer will guide you through the steps required to install PICkit 2 +2.61 on your computer.

WARNING: This computer program is protected by copyright law and interational treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Cancel |

'g‘uﬁ' 2.29 wrhasusnyeulUsunsu@ns PICKit 2

nnuthasusnzolusinsu@ase PICKit 2 (5UT 2.29) Hadnfin Next 1ieling

U

nrhaamnualnamasnuluswnsy (U 2.30) Baundindqluswnsn PICKit 2 azfiasvoy

U

i C:\Program Files\Microchip\PICkit 2 v2\ udauisaszulifiasululnainosduldde

=Y = vt o 4 o o ¢ =X o =1 a
nmMsinnBolnamasiunfidovmuualnanes (HuBolWamasiilusinsuinug) wsoaan
fidn Browse... Wolanisvdmsuidaninamosuaene wastilomuuaiasanals

ARNTIUN Next > Raudhguraawsennts  Fulolusunsufiasldriniswsenns

]
=

AUSURAFILEE D225 ITHNANMSTIUIIGURN 2.31 wavanuuldiadnfivn Next > 8n

q

ASYUIaNo LN THsalU

Unil 2 uuzigenduas. © 2022 lag 9150 UAsITia waznoufia BRI
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15! PICKit 2 v2.61 o B |3
Select Installation Folder

MICROCHIP

The installer will install PICKit 2 +2.61 to the following folder.

To install in this folder, click "Next". To install to a different folder, enter it below or click "Browse".

Folder:

C:\Program Files\Microchip\PICkit 2 w24 Browse...
Disk Cost...

Install PICkit 2 +2.61 for yourself, or for anyone who uses this computer:

% Everyone

" Just me

Cancel | < Back

sUA 2.30 nihehermualnalnesansolusunsy PICKt 2

15! PICKit 2 v2.61 o] @ |[==a)
Confirm Installation
MICROCHIP
The installer is ready to install PICkit 2 ¥2.61 on your computer.
Click "Next" to start the installation.
Cancel I < Back

sUN 2.31 nrhaasigmsHanIsasannsAnavgay PICKit 2

ﬂ' 1l 2/ =} 92/ o Qd 2
LNE’)N']'H?ﬂ']ﬂ‘Vi‘H']fﬂS‘SWEJOWHNaﬂW‘SLG]‘SEJ24ﬂ’]‘i?{ItL“fJH‘HHWf’DE)?J@\ﬂﬁ']U‘S‘SEJ']EJﬁ‘HSﬂ']‘ST‘?J

lUswnsn (SUA 2.32) Wesmau azdovvonsudomnuadunainsiunisidon I Agree
waaAdnfiUn Next > waldlusunsuBiamarinsfasulinee] anasovaoNRnaslé
(U 2.33)

unfl 2 ukzihgandls © 2022 lay 9150 UASIia waznoufa WNKIA
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) Pickit 2 v2.61 ol @ (=
License Agreement @
MicROCHIP

Please take a moment to read the license agreement now. If you accept the terms below, click "
Agree", then "Next". Otherwise click "Cancel”.

IMPORTANT: 4
YOU MUST ACCEPT THE TERMS AND CONDITIONS OF THIS |
LICENSE AGREEMENT TO RECEIVE A LICENSE FOR THE
ACCOMPANYING SOFTWARE. TO ACCEPT THE TERMS OF
THIS LICENSE, CLICK "I ACCEPT," OR OPEN THIS PACKAGE
AND PROCEED WITH THE DOWNLOAD OR INSTALL. IF

'YOU DO NOT ACCEPT THESE LICENSE TERMS, CLICK "TDO
NOT ACCEPT." OR DO NOT OPEN THIS PACKAGE, -

" | Do Not Agree

Cancel | < Back | Next > |

sUAl 2.32 wihaousseuandueemsiflusunsy PICKit 2

1 PiCkit 2 v2.61 [o] @ @3] [ rickt2v261 [o] @ (=)
Installing PICkit 2 ¥2.61 Q Installing PICKit 2 v2.61
MicrocHIP MicrocHIP

PICkit 2 ¥2.61is being installed. PICkit 2 v2.61 is being installed.

Please wait... Please wait...

sU7l 2.33 nihaesrtemsannAunihlunsfaasluswnsy PICKt 2

WolUsinsuuansriaalushnsuevgufl 2.34 waauitmsanslusinsa PICKit 2
Wulddnluanasaduudy Iudunontldadnfidn Close iWalansyinmugosluswnsnan

s hazaziiuiflomon (SUA 2.35) wazsiunistusunsnaoulusinsy PICKit 2 fiasvot)
Iuszuudnfiseusoy

Unil 2 uuzigenduas. © 2022 lag 9150 UAsITia waznoufia BRI
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1) PICkit 2 v2.61 o] @ ==

Installation Complete

MicrROCHIP

PICkit 2 v2.61 has been successfully installed.

Click "Close" to exit.

Please use Windows Update to check for any critical updates to the NET Framework.

sUA 2.33 wraesieviunaanuansalunsiasaluswnsa PICKit 2

6. 15911 PICKit2

MseaAINsTeINeulUsnsa PICKIt 2 Wuazgniuualaudsalud® 1Hovainnn
AsYALlUSWNSH PICKIt 2 BHARYNIHATAARNISASIAFDUFANIHE D0 UDSALUSUNS NBNT

]
=) 1

Foudorunasngioadinduadonlusunsufl PICKit 2 $dnudeld lglusunsuazasia
douamHzToILsIuLazUssinnzasBnlalasaoulnsalaesAifndotjunad oalusunsy

msiSunlusunsy PICKit 2 vhld 2 38 o Bunanloneusosufl 2.34 WiaiSun
Funmestemsiglusunsianugsudugeiuland  udiannwuazihguiaslusunsy
wadn (SUAl 2.36) uddhmsisenlusunsustndumsiBonldadousn a:dnihae (SUA 2.35)
wanviusiouanlimsiuilusunss PICKit 2 dovnsfiazusuusessuuuiuimsond
azBonlridlusunsuriney BuedovadndiUu anas Wielimsduinumsdanaiiduiuse
&1

sUT 2.34 lomaulusunsy PICKit 2

Update Operating System @

PICkit 2 Operating System must be updated
before it can be used with this software
version.

Click OK to download a new Operating System.

anaE ] [ UnLan

unfl 2 ukzihgandls © 2022 lay 9150 UASIia waznoufa WNKIA
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AnaNnaiNee2e

SUN 2.35 nr@aeNEunIsYeINAs SNy PICKt 2

PIC16/18

glusunsy PICKit 2 lanuiagovlusunsuBnaznssieinin PICKit 2 not found.

Check USB connections and use Tools->Check Communication k)reny.(EU?12;36)

FanuuANNIUs NS NIHNUMS B NADSe I UDS AL USWASHBNWAULAS DURT  TsiaLiin

nsBondovasalUswnsudniidugoainasalisuusoy  wuavvanWudansiunis
Check a1nwuy Tools LadHNNSASIAdDUMSITONADENASY LATINSITaNFADS I

TUsunsuiuuasalUsuNsNBNANMSIBoNAD AN 295 HNATIGUNT 2.37 WSoNTIOR

=

Foanus1uvuaadn PICKit 2 found and connected. PIC Device Found. wEansiaszu

A2871

su

fl

q

ﬁ@ﬁﬂ(Devme)1yuua§@FU%uﬂ5N%wﬁa PIC16F877

H PICkit 2 Programmer
File Device Family Programmer Tools View Help

Midrange /Standard Configuration

Device: PIC16F882 3FFF 0700

User Ds:  FF FF FF FF
Checksum:  3EFF

PICkit 2 not found. Check USB connections and
use Tools->Check Communication to retry.

[ Read | [ wte | [ Vedy | [ Emse | [ BankCheck |
Program Memory

Enabled Source: |None (Empty/Erased)

[E=8ch =)

ﬁ\ MICROCHIP

VDD PICkit 2

[] MCLR

000 3FFF 3FFF 3FFF 3FFF 3FFF
oog 3FFF 3FFF 3FFF 3FFF 3FFF
010 3FFF 3FFF 3FFF 3FFF 3FFF
01g 3FFF 3FFF 3FFF 3FFF 3FFF
020 3FFF 3FFF 3FFF 3FFF 3FFF
028 3FFF 3FFF 3FFF 3FFF 3FFF
030 3FFF 3FFF 3FFF 3FFF 3FFF
03 3FFF 3FFF 3FFF 3FFF 3FFF
040 3FFF 3FFF 3FFF 3FFF 3FFF
04g 3FFF 3FFF 3FFF 3FFF 3FFF
050 3FFF 3FFF 3FFF 3FFF 3FFF
058 3FFF 3FFF 3FFF 3FFF 3FFF

3FFF  3FFF  3FFF
3FFF  3FFF  3FFF | |
3FFF  3FFF  3FFF
3FFF  3FFF  3FFF
3FFF  3FFF  3FFF
3FFF  3FFF  3FFF
3FFF  3FFF  3FFF
3FFF  3FFF  3FFF
3FFF  3FFF  3FFF
3FFF  3FFF  3FFF
3FFF  3FFF  3FFF
3FFF  3FFF  3FFF  ~

EEPROM Data

) s

Auto Import Hex
+ Wite Device

00 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF Read Device +
10 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF Export Hex File

20 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF e
30 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF « Plcklt 2

2.36 BENE19UaNYovlUsLASH PICKIt 2 wazsnanWliEns1uNtinueS 0 lUSwWASNBN

Unil 2 uuzigenduas. © 2022 lag 9150 UAsITia waznoufia BRI
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& PICKit 2 Programmer ol @ ==

File Device Family Programmer Tools View Help

Midrange/Standard Configuration

Device: PIC16F877 3BFF

User IDs: FF FF FF FF

Checksum:  1BFF
|PICkit 2 found and connected. ;

PIC Device Found. @ MICROCHIP
‘ | VDD PiCki 2
[0 On 5.0 2

[ Read || wite || Vedy | [ Emse |[ BankChesk | [ MR 2

Program Memory
Enabled Source: |None (Empty/Erased)

0000 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF  +
0008 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF [
0010 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF
001g 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF
0020 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF
0028 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF
0030 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF
0038 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF
0040 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF
0048 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF
0050 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF
0058 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF ~

EEPROM Data

Auto Import Hex
Enabled +Wiite Device
00 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF 4 Read Device +
10 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF| | Export Hex File
20 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF e
30 FF FF FF FF FF FF FF FF FF FF £F fF £ FF 6F fF ~| | PICKit 2

W

sUR 2.37 nrhshandnaealusunsy PICKit 2 wazsienulinsiuimuiedoslusunsudn

msilauiu fo mstuinudngmdunn weldidmsurhdonannuiluivininily
lHausumslusunsnaudnlalasaoulnsaiaassoly

msOauiurilddismsidondiy File zodlusunsu PICKit 2 wazidonsions
Import Hex (5Uf 2.38) vdolduiudn do neaudiu Ctrl Aoudnaududnus I wdean
¥iunrieng Import Hex File Usingduan (5UA 2.39) dusulinmdonuiafidosnsin
v eldeniadaledndiUn e dlusunsuanansarhduiugiwaunnlddndan:
S1ENUHANSTNHGISUR 2.40

ﬁ PICkit 2 Programmer
m Device Family  Programmer
Import Hex  Ctrl+I
Export Hex Ctrl+E

Exit Ctrl+Q

SU7I 2.38 vty Import Hex waulusinsy PICKit 2

unfl 2 ukzihgandls © 2022 lay 9150 UASIia waznoufa WNKIA
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AnavnailNeielg PIC16/18

B Import HexFile @
@LJ" . « mikroBasic PIC » Code » Lab001 ~ [ 4 |[ e Labo0r o
sasndoy v Twmendlwi =~ 0 @
Xt swmslusa Taun3 onms - S

- Jatiuemsr  wawaad v
& amiilima Lab001
B andioy
El dhumsiaionga | =
- lawnz
o e
& smw ctPICOL hex
Bk
3 ans
M anuBaand A%
Foudlsr ctPICOLhex ~ | HEX files (“hex) -

sUM 2.39 w¥iae Import Hex File wovluswnsy PICKit 2

‘Hex file sucessfully imported.

sU7 2.40 s1evumamsHiuing1uiunneoalusinsa PICKit 2

MsAsIadUANNNSoNlUsUNS NI ENMEoMsTuuanda (Blank Check) #a
msastageudnlulasraulnsaaosiniondeld  Fufianunanesniuntoiznlulas
AoHlNsalaeskarIuNSlUsLNSNEoNaNIno WG olA

mMsdimsifionsiaseuanundenlusinsuzeednrilddionsidonsiomsiuyf
13un91 Blank Check (5Ufl 2.41) Faifiusiomsdosannuuy Programmer #3oadnany
Blank (5Ufl 2.42) lélagmsy

W Tools View Help
Read Device Ctrl+R
Write Device Ctrl+W
Verify Ctrl+Y
Erase

| Blank Check
Verify on Write

[<]<]

Clear Memory Buffers on Erase
Hold Device in Reset

Alert Sounds...

Write on PICkit Button

Manual Device Select

PICkit 2 Programmer-To-Go...

sU 2.41 iy Blank Check wavlUswnsa PICKit 2

Unil 2 uuzigenduas. © 2022 lag 9150 UAsITia waznoufia BRI
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| Blank Check |

SUTl 2.42 YJuend Blank Check woulusunsa PICKit 2

°

\flodumsastadeuanundonlusinsugeadn slusunsy PICKit 2 asfufiums
astadeugUnsaiiuglusunsulundmdola (SUA 2.43) wasdmuiBnioan
Fonunuthy Inldldgnlusunsuanounifazdiiinnmsasisgeuanundaulusunsuzos
BN AreuNaISUR 2.44 wadBngalusunsuanien dovsuiumsdvaudoyalusn

AauluswAsLENlUnHLaND

‘Checking if Device is blank:
Program Memory... EE... UserlDs... Config...

| |
|Read || Wiite || Verify || Erase || BIankCheck]

SUA 2.43 wihaes1uvuaawensyin Blank Check gauluswnss PICKit 2
-—

| Read || Wite || Vedy || Emse || Blank Check

sUAl 2.44 wihaosiomunainBnndondusugnliusunsuzavlusinsy PICKit 2

msau fo msdulilusunsu PICKit 2 dufiunmsaudoyafiAusglugneeonlu Fv
litoyafiogdouniiiumeluaindn  wazflomsaudoyaludmadadiuacyilisnd
anungondmsumslusunsadnasudoly woniduand Inflauiunuaongmslinmuga

liaasaduinmsau wioluswnsusalUlasn
wnsavaudoyaludnihléddionsadnfidn  Erase (UM 2.45) wdvaInuw

lWsunsu PICKt 2 2zauAunsavaudonaludn wardaniunsdnsaass1uIuna i

Erasing device...Complete

Erasing device...Complete

l

| Read || wite || Verfy || Emse || BankCheck

unfl 2 ukzihgandls © 2022 lay 9150 UASIia waznoufa WNKIA
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SUT 2.45 wihaosiuuwnansdvaudoyaludngevlusunsu PICKit 2

mslusunsa #o Mmsdafierhioyafiiiannuiingindurniuuasludin
orhanfignlusunsundrfilulinumsanageumsnuiuvesamuauildooniuuion
13 msdslusunsuamnsarhldlaumsadnfiva Write wdvanuwnlusunsy PICKit 2
azpsIvFoUAMUzIogUnsl (SUAl 2.46) wazdufiumsiBondoyaalusdn gare
Wodufiunmsi@onaudiaassisnuanududalumsiusunsudnlinsiudissioanuh
Programming Successful. (‘g‘dﬁ 2.47)

‘Verifying Device:
Program Memory... EE... UserlDs... Config...

|
|Read || Wiite |[Venfy |[aase ]| Blank Check

sUT 2.46 wihasuaaunsainmsiBunionaaudnovluswnsy PICKit 2
e ————

Read | Wiite | Verify H Erase || Blank Check |

—

sUAl 2.47 wrhaos1snuanuddalunmslusunsudnezaslusunsy PICKit 2

msastadgeuaANNgndey Ao msdvlilusunsu PICKit 2 astadoudoyaludn
lalasaoulnsataedinuasoiuiuioyadivhidnunanuilugiuaunnusela Sonmsrh
msasiadeuANugndeviifianudAyetemnn Wovan ddeyaludnlulasaoulnsias
slainsefuioyafidovnsifuniunansanuinisidondanufanaiauazinadonis
yuwzeudriioidnilluliom fumgil Aonfazihdnlulgazedeswdufisesnsiasou
Anugnsoviowhluldoane

msdeasrageuanugndovrhlddiumsadniidu  Verify wdoanuulusinss
PICKit 2 azsufiumsdumsasiadougunsal (Ul 2.48) uazthnuidoyaludnlulas
ﬂE)‘LAI‘Vl‘SaLaa%ﬁuﬂiﬂﬁuﬁUﬁaﬂﬂa‘ﬁ'ﬁ%ﬁﬁmﬁQ’]ﬂLLﬁN@;’mﬁUwﬂ (ﬁas&aﬁﬁm%uaﬂu%w
lalasmoulnsaiass) azsnoiunain Verification Successful. (SUl 2.49) Senunsany
Tiloyaanri 2 uwnauriufianuaseiu

unit 2 uugiinganduas. © 2022 lag 9150 UASITID waznaufia BNk
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‘Verifying Device:
Program Memory... EE... UserlDs... Config...

I |
[Read H Wiite H Verify H Erase H Blank Check

SUT 2.48 WHa0laasMsaLiuMsASIadoUANNNFDVIDIlUsINSH PICKt 2

e

\ Read H Wiite Verify | Erase H Blank Check |

SUA 2.49 wrhaes1ionuaniadSalumMsasiageuaNHgnaovgalUsinsy PICKit 2

nseifinMsasradeulinafiliasuiu dovdvau wadlusunsuluidnasy drdvaala
asviiudnldinsIadougHIudnlnlasAouinsaaasasuAuldalUsunsHINe N IWmG ol

o ' |

F0E10LEH TWMSWINWISEUUSEUSHTvlnlasAoulnsaiaastln PIC1I6F877 ueldiuuase
flugw PIC18F45 linaaovUsusulinsein navanuudullaniuinaindoulnusnass

Q

Toadind

—

TuvaSondvanmsuilamufisngegrvonadulinamdondnge MsasiageU
Tinafildasoiu Wineasunudsudmdudnslud ovanurisanuilusunsnaoedn
HurNeogMsYU udagalsAf Tuuieade Foudaztudoudenan snAduavanunsa
ynuldegeund Fuaawendnin Wsunsy PICKit 2 e1a9zfdounnseoy walinan
szezafilFlunsSoasiionsiagounsasaiuiuinAruwamonls

MslUswnsHBn PIC16F877 éaelusunsd PICKt 2 asdournmsmuuasssiuusy
¢ vDD Tl 4.5 Fuludvazrihlinmsiusunsudndniumslddnda dogufl 2.50 niolw
adnidenfisiumsiuy Tools wazidensiomsgesiie Target VDD Source wazlden
s1omsilu Force PICKit 2 #osufl 2.51 ieldonunavanglndmsuiduvusnanasos
lUsunsuBnunumsidunavinslnanuasanaasy

unfl 2 ukzihgandls © 2022 lay 9150 UASIia waznoufa WNKIA
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g PICkit 2 Programmer

File  Device Family Programmer Tools View Help
Midrange/Standard Configuration

Device: PIC16F877 Confiquration:  3B7A

UserIDs:  FFFFFFFF

Checksum: 2670 OSCCAL BandGap
g raven s (K Misocs
l | VDD PICkit 2

On

| Read || wite || Very || Emse || BankChesk | [ mcir

Program Memory

Enabled Source: |C:\._kroBasic PIC\Code\Lab003\ctPIC03 hex

0000 2803 3FFF 3FFF 1683 1303 0l1gs 30FE 1283 ~
0008 0088 300D 00FB 30AF 00FC 30B6 00FD 0BFD | |
0010 280F 0BFC 280F 0BFB 280F 0000 30FD 0088
0018 300D 00FB 30AF 00FC 30Bé6 00FD 0BFD 281E
0020 0BFC 281E 0BFB 281E 0000 30FB 0088 300D
0028 00FB 30AF 00FC 30B6 00FD 0BFD 282D 0BFC
0030 282D 0BFB 282D 0000 30F7 0ogs 300D 00FB
0038 30AF 00FC 30B6 00FD 0BFD 283C 0BFC 283C
0040 0BFB 283C 0000 30EF 00gs 300D 00FB 30AF
0048 00FC 30Bé6 00FD 0BFD 284B 0BFC 284B 0BFB
0050 284B 0000 30DF 0088 300D 00FB 30AF 00FC
0058 30B6 00FD 0BFD 285R 0BFC 285R 0BFB 285A ~

EEPROM Data

Auto Import Hex
Enabled | Hex Only v + Write Device
00 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF ~ Read Device +
10 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF| | Export Hex File
20 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF -
30 FF FF FF FF FF FF FF FF F FF fF £F £F fF fF fF ~| | PICKit 2

sUA 2.50 Muuausedu VDD Tumslusunsugnsnelusunsy PICKit 2

Tools | View Help
Enable Code Protect Ctrl+P ks
Enable Data Protect Ctrl+D
OSCCAL b o

| Target VDD Source » I Auto-Detect
Display Unimplemented Config Bits » Force PICkit 2
Calibrate VDD & Set Unit ID... Force Target

I Use VPP First Program Entry I'r

SUA 2.51 MuuaLsdn VDD lumslusunsudnlinianesoulusinsy
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